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I. Archive Overview

Thank you for downloading a newsletter template from www.FreeMailTemplates.com. In this

short tutorial we will show you how to organize and use our templates with web based email
platforms (MailChimp and Campaign Monitor) and with desktop email clients (Outlook and
Thunderbird).

First, let's take a look into the ZIP file you've just downloaded. It contains:
+ Folder “slices”.

- Folder “images”.

* HTML file "email”

* HTML file “email-campaignmonitor”.

* HTML file “email-mailchimp”.

Once you extract the ZIP file on your computer, the folder should look like this:

M ~slices

| images

|| email.html

D email-campaignmaoniter.html
|| email-mailchimp.html

(ZIP file contents)

The folder “slices” contains a PSD file for customizing the look and feel in Adobe Photoshop. The
“images” folder includes all images used in this email template. The HTML file “email-campaign-
monitor.ntml” should be used only with Campaign Monitor. The HTML file “email-mailchimp”
goes only with MailChimp. The last file, “email.html” should be used with all other web and desk-

top email platforms like Emma, Constant Contact, iContact, Thunderbird and Outlook.
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ll. Customize our Templates

Basic Design Customizations

Before you upload our email template and start a campaign, you may customize the look and
feel. However, if you are using MailChimp or Campaign Monitor, you would be able to replace
the logo and the rest of the images by using their web editor. In case you are going to send the
templates with a desktop email client (such as Outlook and Thunderbird), you'd better custom-
ize the graphics first. This will save you a lot of troubles, as replacing images in Outlook and
Thunderbird could cause issues with the code. Go to the “images” folder and replace the logo
with your own. Then, check the rest of the images - do they fit your taste? If you need to make
some modifications, use your favourite image editor and then replace the images. Once you are
done with the graphics, you could also edit the text. Use any text editor (notepad for example)
and open the “email.ntml” file. Then replace the “lorem lipsum” text with your own. Once you
are ready with all modifications, you could go on with sending the email.

Design adjustments using Adobe Photoshop

We've included a fully layered PSD file in the “slices” folder, which could be edited in Adobe Pho-
toshop. Use the PSD file to replace all banners, logos, featured areas and buttons with your own
text and graphics. We advise you to use Adobe Photoshop for editing our templates, as that's

the best way to customize the graphics. Let's take the featured area as an example - change the

text, colors and effects to fit your own taste.

Slices

All PSD files are sliced, which means that you don't have to create slices on your own, as they
are already there. Here's a quick example that will give you a clear idea how to use the slices.
Start by turning on your slices from “View -> Show -> Slices”:
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(Activate the slices from “View -> Show -> Slices”)
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All slices are now visible and you can see the slice/s related to the featured area. Pick the “Slice
Select Tool” and double click on the slice to see its name. It's a better workflow to check the
name of the image before you save it, but it's also okay to do that later. It's your choice.

— Slice Type: Image L oK
Name: | Cancel |

LIRL:

Target:

Message Text:

(Copy the name of the slice)

The name of the image goes in the first field “Name”. Copy the name (in our case “featured_
img").

Now, let's save the image. Use “File -> Save for Web” (Ctrl+Alt+Shift+S)” to export the image.

Plan Your Next
Destination

R Hél
Heading Title Goes
Right Here

ol s [&]

(] | @ 5]

(Save as JPG, 100 Quality)
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Select JPG as file format and set the quality to 100. Then, select the featured area slice and hit
the “Save” button at the bottom of the screen.

Then paste the name of the slice in the first field “File name” and choose “Selected Slice” from

the “Slices” dropdown:

File name: featured_img jpg
Format: Images Only
Settings: Background Image =

(Paste the name here and choose “Selected Slices”)
Now, replace the new image with the original file located in the “images” folder.
That's it, your featured area is now ready to go! You could go over the same steps to change the

rest of the graphics in our email templates. Once you are ready, just replace the new images
with the original files.
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lll. MailChimp Integration &

Organize the files for MailChimp

Before you upload your template to MailChimp, you have to create a ZIP file that contains:

- folder “images”

* email-mailchimp.html

The name of the ZIP file is not of importance to MailChimp, so just type something that will help
you to easily identify the design later.

Upload the email template to MailChimp

If you haven't used MailChimp yet, you'd better create a new account. That's the signup page:
https:/login.mailchimp.com/signup If you already own a MailChimp account, please proceed to

the login page: https://login.mailchimp.com/

Once you've logged into your account, the Dashboard page will show up. Go to the “Campaigns”
subpage by using the left navigation. Then, hit the “My Templates” button at the top of the page,
which will open your email templates library. To create a new template, use the “Create Tem-
plate” button. Then, press the “Code a template” text-link at the right column of the page:

Templates
Pick a template to start with
Fra : Do e coues

o i Berryslaln

n n Imnport

E-_j Regeonta Irmpeet el e Lemplafon
oepe] edirtucs.
Basic Predesigned
L Actereapondon e
STk Ly spaly Bl Tl iy ke
o . e aemigr mred corford. e corgenl. Meed some inspiration?
Lol bl e i 63wy AT
B Faabial{l

(Select “Code a template”)
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Then, the code editor will show up. At the top of the page, there’s a row of buttons. Locate the
“Import & Export” button and select “Import a zip file” from the dropdown menu. Choose the

ZIP file that we've created in the previous step.

&

{ Back Preview & Test v Import & Export Refresh

Ve

Import zip file —

View options

| Code l Design | Export template

(press “Import zip file” from the dropdown menu)

Once the ZIP file is uploaded, go to the “Save” button and type a name for the template. Just type
something that will remind you of that template. Don't worry, it won't be visible to the public.

Almost done. Now, it's a good idea to replace the images and text if you haven't done this yet. Go
to the "My Templates” page and click the edit button below the email template.

(press “Edit” to customize the template)

MailChimp has an easy to use online editor where you can add/remove/hide/duplicate sections or
drag them to new positions. Editing the text is also pretty easy, just hit the “edit” button, put your
own text and then click the “Save” button. If you haven't changed the images before uploading the
template, now it's a good time. Move your mouse over the image that you need changed and then
press the “change” button that will appear at the top of the section.

If you want to add a link to an image, you will have to upload the image again. Select the image,
press the “change” button and choose the same image from the “images” tab. Then, in the “Link to
URL" field, paste your link and press “Save & Insert Image”.
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Image Properties
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(paste the link into “Link to URL" field)

MailChimp merge tags

MailChimp provides plenty of merge tags that will help you to dynamically add content to your
emails. Use these tags to personalize and customize your campaigns and list forms:

- mc.edit="text", where “text” should be unique text string
- mc.edit="title", where “title” should be unique text string
+ mc.edit="image”, where “image” should be unigue text string
* mcrepeatable

- *UNSUB | *

+ *| FORWARD | *

+ * | ARCHIVE | *

+ * | UPDATE_PROFILE | *

- % | EMAIL | *

+ *| LIST:ADDRESS | *

+ | LIST:COMPANY | *

+ * || CURRENT_YEAR| *

- * | DATE | *

Once you are done with the design, press the “Save & Exit” button at the top of the page. Now,
you can start a new campaign with our email template!
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IV. Campaign Monitor Integration

Organize the files for Campaign Monitor

Before you upload your template to CampaignMonitor, you have to create a ZIP file that con-
tains only the folder “images”. Do not include there the HTML file “email-campaignmonitor”. It

will be uploaded separately from the images.

Upload the email template to Campaign Monitor

If you haven't used CampaignMonitor yet, you'd better create a new account. That's the signup
page: https://signup.campaignmonitor.com/signup If you already own a CampaignMonitor ac-

count, please proceed to the login page: https://login.createsend.com/I

Once you've logged into your account, the Dashboard page will show up. Let's go to the tem-
plates section and upload our files. Click the “Templates” button at the top of the page and then

hit the “"Upload your own” button.

Cﬂmpﬂig“ Monitor Free Mail Templates

Orsarview Create & Send Lists & Subscribkers Reports Client Settings

Add your first template

Usa the template buikder 1o design a beaulitul email template mn just a tew clicks, or upload your own

1 1 o 15 - I M| S5 r o el (] o e
cusiom template built with our simpie lempiate languaage.

Launch template builder Upload your own

Want to design your own templates?

(Press the “Upload your own” button)

10
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Now, in the first field “Template Name” type a name that you will easily identify with the design.
Then, proceed to “The HTML page” section and use the select button to choose the “email-cam-
paignmonitor.html” file from your folder. Then, in the “All other files in zip format” section, use
the select button to choose the ZIP file that we've created in the previous step. Finally, press the
“Add template” button to upload the template to your personal library.

Template Name
Give your ternplate a name that your client willl easily identify with the design - maximum of 30 characiers.

Template Mame  FreaMailTemplates

The HTML page
Browse o the location of the HTML page you have created for this template. Your page can be in any format.

HTML page |- - Sl ] email-campaignmonitor html

All other files in zip format [optional)

Any other filas you creafed for thes femplate, such as image files and G55 files should be zipped inte one fils.
created. I you need halp with this step, read our tiorial on Zippendg fHles.

Zmp fis | | images.zip

el

(Upload your sources to the Campaign Monitor library)

Don't worry if you haven't customized the email template before uploading to Campaign Moni-
tor. There's an easy-to-use online editor that could help you to change images and text in a few
clicks. So, let's start a new campaign and use the template that we've just uploaded.

Campaign

Go to the “Create & Send” tab and press the green button at the right sidebar “Create a new
campaign”. Then, you will have to enter a name of the campaign, subject and fill in an email ad-
dress that will appear in the “From field” of your recipients.

11
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Design

Now choose “Use one of my templates” and select the email you've just uploaded. The online
editor will show up. Here you can change the text, add links, add/remove sections and drag
them to new positions. Just use the buttons at the top of each section. If you want to add a link
to an image, press the edit button once you are on that section and then hit the settings button
(a gear icon on your left). Select “Add link” from the dropdown menu.

(Select “Add link” from the dropdown menu)

Then just press “Save changes” to apply the link to the image. Once you are done with the de-
sign, press the green “Preview” button at the top of the page.

Campaign Monitor tags

Here's a list of Campaign Monitor's tags that could be used in our email templates. These tags
will help you to personalize the emails you send, add unsubscribe links, place automatically
dates and most importantly, to create re-usable email templates.

* <singleline> + <preferences>

+ <multiline> + <currentday>

* <img editable> + <currentdayname>

* <repeater> + <currentmonth>

* <unsubscribe> + <currentmonthname>
» <forwardtoafriend> « <currentyear>

-« <webversion> * [email]

12
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Recipients

In this step you will have to select who will receive this campaign. You may choose a list that has
already been made or import new subscribers. Either way, we suggest you to send emails only
to people that have opted to receive emails from you.

Snapshots

Next comes the snapshot. Here you can preview your settings and make final edits if necessary.

Test

Generally, a manual test is a good idea, as most of the email clients display email designs differ-
ently. We have already tested our emails to a wide range of email clients, so you should test the
email template only if you have made considerable changes. If not, just press the “Skip the test”
button.

Schedule

In this step you can choose whether to send the campaign immediately or have a schedule.
Take your time here to plan precisely the frequency of sending the email campaigns. Experi-
ment with sending emails during different periods of the day and decide whether it's better to
send emails on business days or during the weekends.

V. Other Email Platforms

Our email templates could be used also on other email platforms such as Constant Contact,
Emma and iContact. Use the same “images” folder combined with the HTML file “email”. You can
also send our email templates by using a desktop email client such as Outlook and Thunder-
bird. Here are the steps that you should follow:

Thunderbird:

1) First you have to upload all images to your hosting. Login to your server via FTP, go to the
root folder - usually “public_html”, “www" or “html". Create folder for your email images and
name it “mail-images”.

13
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2) Upload all images from the folder “images” to your FTP folder “mail-images”.

3) Now open “email.html” with any text editor (notepad for example) from the archive you have

downloaded.

4) Replace all image source paths, so all images point to your hosting - http://yourdomain.com/
mail-images/image.gif. You can do that by using the option “Find and replace” - find “images/’
and replace it with “http://yourdomain.com/mail-images/’

5) Now that you have changed the images, open email.html with your browser to make sure all
images are loaded.

6) Open Thunderbird and press “Write".

7) Click on the message area and then press “Insert” - “HTML". Copy all the html code from
“email.html”, paste it there and then click “Insert”. And that's it! You're now ready to send your
template!

Outlook

1) First you have to upload all images to your hosting. Login to your server via FTP, go to the
root folder - usually “public_html”, “www" or “html". Create folder for your email images and

name it “mail-images”.

2) Upload all images from folder “images” to your FTP folder “mail-images”.

3) Now open “email.html” with any text editor (notepad for example) from the archive you have
downloaded.

4) Replace all image source paths, so all images point to your hosting - http://yourdomain.
com/mail-images/image.gif. You can do that by using the option “Find and replace” - find “im-
ages/" and replace it with "http://yourdomain.com/mail-images/".

5) Now that you have changed the images, open “email.html” with your browser to make sure

that all images are loaded.

6) Open Outlook and click on “New".
14
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7) Click on “Attach file".

8) Select the html file - email.html, click on the “Insert” button drop down menu and select
“Insert as Text".

9) You're now ready to send your template!

Useful Articles

Here are some useful articles that will help you with your email campaigns:

* MailChimp help resources: http://mailchimp.com/resources/guides/getting-started-with-
mailchimp/html/

* How do | upload and edit images in MailChimp? http://kb.mailchimp.com/article/how-do-i-
upload-an-image

* How do i create new list in MailChimp? http://kb.mailchimp.com/article/how-do-i-create-a-
new-list

* How to import a list in MailChimp: http://kb.mailchimp.com/article/how-do-i-create-and-
import-my-list

» Create your first campaign with Campaign Monitor: http://help.campaignmonitor.com/

- Campaign Monitor Template Language: http://www.campaignmonitor.com/create/edit-
able-content/#primary

* Quick glossary of all content tags in Campaign Monitor: http://help.campaignmonitor.com/
topic.aspx?t=97

* How to create e-mail template in Outlook: http://office.microsoft.com/en-us/outlook-help/

Create-an-e-mail-template-HA001086500.aspx

15
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FocusMail - Premium Email Template

V/sit Chocolemplates.com
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Email Template Coding Services

Email Template Coding Services from www.MailBakery.com

MailBakery helps you code email newsletters. They simply convert your design (PSD, PNG, Al, etc.)
into a hand coded email friendly html which is compatible with all major email applications.

They offer 2 price options depending on completion time. Both options include maximum pos-
sible compatibility with different email clients. In addition they can integrate the coded template.

BUSINESS
DAYS f

L l'. 0
e N

Supported email platforms:
+ Outlook (even 2007)

* Apple Mail

+ Windows Live Mail

* Yahoo! Mail

+ Gmail

* Thunderbird

* Hotmail

+ Lotus Notes

\Visit MallBakeny.com
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